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Statistics and Data Analysis (OA3604)

Lab #1: Descriptive Statistics with R

Goal: Introduce students to various R commands for descriptive statistics. 
Lab type: Interactive lab demonstration followed by hands-on exercises for students.
Time allotted: Lecture for ~50 minutes 
R libraries: Just the base package.
Data: iraq.csv[footnoteRef:1] [1:  Data from http://turtle.gis.umn.edu/pmwiki/pmwiki.php?n=StatisticsandDatawithR.Application TheShapeOfWarsToCome (file titled "iraq.dead.rda").] 


DEMONSTRATION

1. Now, before we begin, let's talk a bit about R scripts.  All the commands in all of the labs we will do in this class will be posted on Sakai in the form of R scripts.  Why do you care?  Because the script is an easy way to follow along in the lab, executing all the commands that I do, but without having to type them in!  
R scripts are also a great way to document what you have done in a particular analysis (so you can repeat it later, for example).  Along with the R Editor, R scripts can also make it easier to work with the R command line.
An R script is basically just a text file that ends with a ".R" extension.  After opening it in R (PCs: File > Open script; Macs: File > Open Document), you can execute the commands right from the Editor window:
a. PCs: Put the cursor on a line and hit Ctrl+R.  Note that the cursor automatically moves down to the next line so, if you want to execute a sequence of commands, you can just keep hitting Ctrl+R.  Alternatively, you can highlight part of a line or a bunch of lines and select Edit > Run line or selection, or if you want to run everything in the script, choose Edit > Run all.
b. Macs: Put the cursor on a line and hit Command+Enter.  Note that, unlike on the PC, the cursor does not automatically move down to the next line.  Alternatively, you can highlight part of a line or a bunch of lines and hit Command+Enter.
So, if you're going to follow along in the lab, download the R script called "Lab 1 Script.R" from Sakai and load it into your R Editor window.
2. So, on to the lab!  For this lab, we're going to use a dataset from Statistics and Data with R by Cohen and Cohen (2008).  It contains detailed casualty information from the Iraq war from 21 March 2003 to 10 October 2007.
To begin, download the dataset from the course Sakai site and read it into R.
a. Since the data are contained in a comma delimited file use read.csv() command.  There are a couple of ways to do this.  First, you can explicitly tell R where to find the file, as in (where you will need to modify the path to correspond to the file location on your computer): 
iraq <- read.csv("/Users/Ron Fricker/Desktop/iraq.csv", header=TRUE)
An easier way I recently discovered is to use the file.choose() command with the read.csv() function.  This will allow you to simply browse for and select the file you want to read in.  For example: 
iraq <- read.csv(file.choose())
Either of these commands reads in the CSV file and puts it into a data.frame object called iraq.   
3. [bookmark: _Toc158521590][bookmark: _Toc194746618][bookmark: _Toc194760980][bookmark: _Toc194761148][bookmark: _Toc194763258][bookmark: _Toc194807759]Now, take a quick look through the data to familiarize yourself with it.  Look at each of the variables to get some idea what’s in them, look for unusual data, etc.
a. First, to get an idea of the size of the dataset, use the dim() command, as in
dim(iraq)
This tells you the number of rows (observations) and the number of columns (variables) in the dataset.
b. To dig a little deeper and get some summary statistics for each of the variables, use the summary() command, as in:
summary(iraq)
Note that the summary statistics that you get for each variable depend on whether the variable is continuous or discrete.
c. To get just a list of the variable names, type:
names(iraq)
d. To look even deeper, browse some of the individual observations.  For example, to look at the first five observations (i.e., rows of data) type
iraq[1:5,]
If you want to look at the complete results for one of the variables, say question Srv.Branch type
iraq$Srv.Branch
or, because it’s the sixth variable in the data frame,
iraq[,6]
4. Now, let's look at ways to calculate summary statistics.
a. At the command line, instead of using the data frame name in the summary command, you can use the summary() function on individual variables, such as
summary(iraq$ Major.Cause.of.Death)
or on groups of variables, such as
summary(iraq[,7:9])
You can also use the self-explanatory commands below to calculate specific numeric descriptive statistics.  
mean(iraq$Age,na.rm=T)
sd(iraq$Age,na.rm=T)
min(iraq$Age,na.rm=T)
median(iraq$Age,na.rm=T)
max(iraq$Age,na.rm=T)
quantile(iraq$Age,na.rm=T)
IQR(iraq$Age,na.rm=T)
range(iraq$Age,na.rm=T)
fivenum(iraq$Age,na.rm=T)
Note that the option "na.rm=T" is necessary for this data.  It tells R to ignore the missing data when calculating the specified statistic.  
For "clean" data sets that are not missing any responses, you can leave that option off.  But, note what happens when you leave it out on this data.  For example, type
mean(iraq$Age)
Of course, these functions only work on numeric variables.  To determine the type of a variable (e.g., numeric, integer, character, factor, logical, etc), use the class() function, as in:
[bookmark: OLE_LINK1][bookmark: OLE_LINK2]class(iraq$Age)
b. How many observations are missing in variable Age?
table(is.na(iraq$Age))
Here the is.na() function generates a logical vector that is true if a value is missing (i.e., its set to  NA in R) and false if it's not.  Then the table() function creates a table with counts of the unique values in the is.na(iraq$Age) vector.
If this seems a bit confusing, first look at what the following command gives
is.na(iraq$Age)
It's just a gigantic vector of "TRUE"s and "FALSE"s, where "TRUE" means Age was missing for that observation.  Then all the table() function does is count up the number of "TRUE"s and "FALSE"s.
This is one of the great strengths of R, once you get used to it.  You can just wrap function around function around function…  R starts at the innermost function, generates its output, feeds that into the next innermost function, which then generates its output, feeding that into the next function…  With this type of functionality, you can write some very compact (and sometime quite inscruitable) code.
c. Now, to figure out how observations are missing in the entire data set:
table(is.na(iraq))
Note that you should be very careful about applying functions to whole data frames.  Indeed, in general you should avoid doing this.  Often the function will fail and other times it's not entirely clear what the function is doing exactly.  However, in this case, it works quite nicely.
d. Now, another strength of R is that you can easily condition on data values (i.e., subset) when doing calculations.  For example, imagine if we wanted to compare the average age of hostile casualties to the age of non-hostile casualties.  Here's an easy way to do that:
mean(iraq$Age[iraq$Major.Cause.of.Death=="Hostile"],na.rm=T)
In words, the above syntax says, "Calculate the mean of the Age variable for those observations where Major.Cause.of.Death is "Hostile."  In the next line, we do the same calculation for Major.Cause.of.Death equal to "Non-hostile."  
mean(iraq$Age[iraq$Major.Cause.of.Death=="Non-hostile"],na.rm=T)
Note the use of the double equal sign.  This is a "logical equals," which is different from a single equals sign.  The former generates a TRUE or FALSE logical value (depending on whether the statement is true or false for a given observation) while the latter is an assignment operator (just like the "<-" operator.  
To see the difference, type the following:
x = 3
x == 4
In the first line, x was assigned the value of 3, while the second returned a value of FALSE was generated since 3 is not equal to 4.  Now, see what the following returns:
iraq$Major.Cause.of.Death=="Hostile"
e. Also, when calculating the statistics, you may want to only do the calculations by various categories of a factor.  Useful syntax for this is, for example,
by(iraq$Age,iraq$Major.Cause.of.Death,summary)
The by() function is saying, "Calculate the summary statistics for variable Age separately for each level of the Major.Cause.of.Death variable."  
5. When exploring data, sometimes it’s useful to look at two-way (or higher) tabular summaries, particularly for discrete (i.e., categorical) variables
a. To generate a simple table of counts, say for variables Rank and Major.Cause.of.Death, use
table(iraq$Rank,iraq$Major.Cause.of.Death)
b. You can generate higher-way tables by adding more variables separated by commas.  For this dataset, even a three-way table is unwieldy, though.
6. Now, in addition to looking at numerical summaries, it's often very useful to look at graphical summaries.  Here are some examples.    
a. Bar charts for categorical variables are easily generated with 
barplot(table(iraq$Major.Cause.of.Death))
If you prefer the bars plotted horizontally, try 
barplot(table(iraq$Major.Cause.of.Death),horiz=TRUE)
And note that you can improve the appearance of the plots by including various options, for example if we wanted to label the axes and the chart we could do:
barplot(table(iraq$Major.Cause.of.Death),horiz=TRUE,xlab="Count",ylab="Major Cause of Death",main="Iraq Casualties, 3/21/03-10/10/07",xlim=c(0,3500))
To convert from counts to fractions:
barplot(table(iraq$Major.Cause.of.Death)*100/length(iraq$Major.Cause.of.Death),ylab="Percent",xlab="Major Cause of Death",main="Iraq Casualties, 3/21/03-10/10/07",ylim=c(0,100))
b. Just like in Excel, you can do stacked and side-by-side bar charts in R.  To keep them from being unwieldy with the full data set, let's create a smaller data set to illustrate:
iraq.sub <- iraq[(iraq$Country=="UK"| iraq$Country=="IT"| iraq$Country=="POL"),]
iraq.sub$Country <- factor(iraq.sub$Country)
Now, let's do some bar charts on this data:
barplot(table(iraq.sub$Country,iraq.sub$Major.Cause.of.Death),
    legend=TRUE)
barplot(table(iraq.sub$Country,iraq.sub$Major.Cause.of.Death),
    beside=TRUE,legend=TRUE)
c. As we talked about in class, histograms are useful for gaining insight into the (underlying) distribution of a (continuous, numeric) variable.  For example, we might want to know what the distribution of the Age variable looks like:
hist(iraq$Age)
Clearly it's skewed to the right.  As with all R plots, we can modify it in all sorts of ways.  For example, here's a fancier plot with the axes labeled, a title added, and a line showing the mean age overlaid and annotated:
hist(iraq$Age,xlab="Age (in years)",ylab="Count",xlim=c(10,70),ylim=c(0,2000),main="Distribution of Age\nIraq Casualties, 3/21/03-10/10/07",col="light blue")
lines(c(26.3,26.3),c(0,1950),col="red")
text(mean(iraq$Age,na.rm=T),2000,"Average Age",col="red")
d. Boxplots are another way to look at the distribution of continuous numeric variables.  For example, 
boxplot(iraq$Age,xlab="Age (in years)",ylab="Count", main="Distribution of Age\nIraq Casualties, 3/21/03-10/10/07")
Compare the histogram and boxplot for Age:
par(mfrow=c(1,2))  #this allows for two plots (side-by-side) 
hist(iraq$Age,xlab="Age (in years)",ylab="Count", main="Distribution of Age\nIraq Casualties, 3/21/03-10/10/07")
boxplot(iraq$Age,xlab="Age (in years)",horizontal=TRUE,ylab="Count", main="Distribution of Age\nIraq Casualties, 3/21/03-10/10/07")
Let's draw in the boxplot lines now to help compare:
hist(iraq$Age,xlab="Age (in years)",ylab="Count", main="Distribution of Age\nIraq Casualties, 3/21/03-10/10/07")
abline(v=median(iraq$Age,na.rm=T),col="red",lwd=4)
abline(v=fivenum(iraq$Age)[2],col="red",lwd=2,lty=2)
abline(v= fivenum(iraq$Age)[4],col="red",lwd=2,lty=2)
abline(v= fivenum(iraq$Age)[4]+IQR(iraq$Age,na.rm=T)*1.5,
    col="red",lwd=2,lty=3)
abline(v=min(iraq$Age,na.rm=T),col="red",lwd=2,lty=3)

boxplot(iraq$Age,xlab="Age (in years)",horizontal=TRUE,ylab="Count", main="Distribution of Age\nIraq Casualties, 3/21/03-10/10/07")
abline(v=median(iraq$Age,na.rm=T),col="red",lwd=4)
abline(v=fivenum(iraq$Age)[2],col="red",lwd=2,lty=2)
abline(v= fivenum(iraq$Age)[4],col="red",lwd=2,lty=2)
abline(v= fivenum(iraq$Age)[4]+IQR(iraq$Age,na.rm=T)*1.5,
    col="red",lwd=2,lty=3)
abline(v=min(iraq$Age,na.rm=T),col="red",lwd=2,lty=3)
e. Side-by-side boxplots (aka as comparative boxplots) are useful for comparing the distributions of two (or more) sets of data.  For example, we might want to compare the distribution of Age for US casualties versus casualties from all the other countries.  To do that:
par(mfrow=c(1,1))  #first, put it back to showing only one plot 
raq$US.indicator <- as.numeric(iraq$Country=="US")
boxplot(iraq$Age~iraq$US.indicator,ylab="Age",
   xlab="US Indicator (1=US, 0=Other country)",notch=TRUE)
f. Now, there are lots of other types of charts you can do in R.  Too many to go into them all here.  For example, a "dot chart" is kind of like a bar chart, except that dots are placed where the top of the bar would be.  For example:
dotchart(table(iraq$Srv.Branch),xlab="Number of Casualties")
g. You can also do pie charts:
pie(table(iraq$Major.Cause.of.Death))
Fancying it up:
pie(table(iraq$Major.Cause.of.Death), main="Iraq Casualties, 3/21/03-10/10/07", col=c("red","blue"))
If you don't like the look of the plot, look at the help page for the available options and modify as desired.  
h. And here's an example of something called a "strip chart":
stripchart((iraq$Julian-12131)~iraq$US.indicator,method="stack",
   ylab="US Indicator (1=US, 0=Other country)",
   xlab="Date (1=3/21/03,1165=10/10/07)",pch=20)
i. Finally, there's an important type of plot we will frequently use to assess whether data is normally distributed.  It's sometimes called a normal probability plot and sometimes a quantile-quantile plot, or Q-Q plot for short.  The latter name arises because it compares the quantiles from a normal distribution to the empirical quantiles from the data.  
Let's see what a normal probability plot looks like for data we know is normally distributed:
par(mfrow=c(2,2))
normal.data.10 <- rnorm(10)
normal.data.50 <- rnorm(50)
normal.data.100 <- rnorm(100)
normal.data.1000 <- rnorm(1000)
qqnorm(normal.data.10); qqline(normal.data.10)
qqnorm(normal.data.50); qqline(normal.data.50)
qqnorm(normal.data.100); qqline(normal.data.100)
qqnorm(normal.data.1000); qqline(normal.data.1000)
Compare to what the Q-Qplot looks like for data we know is not normally distributed:
gamma.data.10 <- rgamma (10,1,2)
gamma.data.50 <- rgamma (50,1,2)
gamma.data.100 <- rgamma (100,1,2)
gamma.data.1000 <- rgamma (1000,1,2)
qqnorm(gamma.data.10); qqline(gamma.data.10)
qqnorm(gamma.data.50); qqline(gamma.data.50)
qqnorm(gamma.data.100); qqline(gamma.data.100)
qqnorm(gamma.data.1000); qqline(gamma.data.1000)
So, let's check to see whether we can reasonably assume the Age data is normally distributed:
par(mfrow=c(1,1))
qqnorm(iraq$Age); qqline(iraq$Age)
Finally, you can also compare two sets of data one against the other using the qqplot() function.  Here's a fancy example:
qqplot(normal.data.1000, gamma.data.1000, xlab=expression(paste("1000 observations from ",N(mu==0,sigma^2==1),sep="")), ylab= expression(paste("1000 observations from ",Gamma(alpha==1,beta==2),sep="")))
To explore all the expression options, see the help for plotmath:
?plotmath



Name: _____________________________

INDIVIDUAL EXERCISES

1. Exploring the Iraq data.
(a) How many records (observations) are in the data set?  _______
(b) How many variables are in the data set? _______
(c) How is a missing observation indicated?  _______
i) How many observations are missing in the dataset?  ______
ii) How many are missing for the variable Country?  ______

2. Calculating basic statistics and creating plots of the Iraq data.
(a) For the Age variable in the Iraq data, calculate the
i) Mean: 			______________
ii) Median:			______________
iii) Standard deviation:	______________
(b) For the Hometown variable:
i) Which hometown had the largest number of casualties in the data?   How many?  (Hint: The sort() function can be useful for ordering the values that come out of the table() function…)  __________________
ii) For how many respondents do not have hometown information?  Note that there are three types of missing data: (i) completely missing (i.e., the value for an observation is NA), (ii) those that are missing but that have a blank space in the field (i.e., the field contains a " "), and (iii) some are "Not reported yet." 
# NAs:			______________
# " ":                            ______________
# "Not reported yet":	______________
(c) Create and attach a frequency histogram and a boxplot of Age only for those with Rank of "Corporal."  Appropriately label the x- and y-axes, and further modify the plots as desired to make them look professional.
(d) Create a table of Major.Cause.of.Death versus the US.indicator created in the lab.  Does there seem to be a difference in the fraction of casualties attributable to hostile causes between US and non-US personnel?
(e) How many casualties are US (i.e., Country is equal to "US")? _______
i) How many of the US casualties were a result of non-hostile causes? _______
ii) Among the hostile casualties, what was the cause that resulted in the largest number of casualties? __________________________
(f) Now, subset the data to only US casualties and create a bar chart for Branch of Service and attach.  That is, first run the following code:
iraq.US.subset <- iraq[iraq$Country=="US",]
iraq.US.subset$Srv.Branch <- factor(iraq.US.subset$Srv.Branch)
iraq.US.subset$State <- factor(iraq.US.subset$State)
Note that the labels are also too long to all print out.  To fix that, use the "las=2" option to turn the x-axis labels 90 degrees.  And, to leave enough room for them to print (some are pretty long), before making the bar plot first run 
par(mar=c(12,3,1,1))
to adjust the margin area for printing.  What do you notice from the bar chart?
(g) Finally, do a side-by-side boxplot of Age by Svc.Branch, where again you will need to rotate the labels using the option "las=2".  What do you notice from the plot?
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